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Introduction to the release notes
This documentation covers installation steps, software changes, and known issues for Dolby Atmos
Renderer v3.4.

• About this documentation
• Contacting Dolby

Introduction to the release notes
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1.1 About this documentation
This documentation is for engineers, sound designers, and others who install or use Dolby Atmos Renderer
software for editorial, pre-mix, and sound design workflows when authoring sound for digital home theater
or VR, and creating Dolby Atmos masters.

Note: This documentation also includes a list of features and improvements added in recent
previous versions. For complete information about these features, see the Dolby Atmos Renderer
Guide .

1.2 Contacting Dolby
You can contact Dolby regarding this product and its supporting documentation.

If you have technical questions about this product, contact your reseller and/or visit https://
developerkb.dolby.com.

If you have questions or comments about this documentation, please send an email to 
documentation@dolby.com.

About this documentation
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New in version 3.4
Dolby Atmos Renderer v3.4 includes new features, improvements, and fixes for using Dolby Atmos
Renderer software to author content in Dolby Atmos.

• Measuring loudness
• New re-render options: 7.1.4 and Loudness
• Limiting on output and re-renders
• Group improvements
• Display of object numbers or binaural distance model settings of objects in objects view
• Synchronization updates
• Trims and downmix controls included with the Production Suite
• Additional improvements and changes
• New in previous versions

New in version 3.4
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2.1 Measuring loudness
You can measure the loudness of a master in real time (when monitoring) or offline. The offline
measurements can be exported as a time line (.csv file) or summary (.txt file).

Real time loudness when monitoring a Dolby Atmos mix
The Renderer provides real-time loudness measurements and metering when monitoring input or playing
back a master file.

Figure 1: Loudness section in the main window

To monitor loudness in real time:

1. Turn on loudness measurement.

a. In the Dolby Atmos Renderer, choose Dolby Atmos Renderer > Preferences to open the Preferences
window.

b. Select (highlight) Loudness to navigate to the Loudness preferences page.

Measuring loudness
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Figure 2: Loudness page in the Preferences window

c. Click the Loudness measurement switch to turn on loudness measurement.

Note: The switch turns blue when on. By default, Loudness measurement is on.
2. In the main window, in the Loudness section, select the type of loudness measurement you want to see.

• Dolby Atmos: Provides loudness measurement for a Dolby Atmos master file based on your selected
5.1 monitoring mode.

• Stereo/Binaural: Provides loudness measurement based on the stereo downmix mode selected for
monitoring, or binaural when Binaural is selected as the Render mode in Headphone preferences.

3. Load a master in the Renderer, or have a mix ready to play via your digital audio workstation (DAW).
4. Play back audio using one of these methods:

• Press play in your DAW (with external sync engaged).
• Press play in the Renderer.

The loudness meters and measurements display real-time loudness information.

Loudness meters, controls, and measurements in the main window

When the Loudness measurement preference is on (as set in the Loudness preferences page), the main
window includes loudness meters, controls, and measurement information. By default, the preference is on.

New in version 3.4
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Figure 3: Loudness section in the main window

Loudness meters: This meter pair displays real-time loudness information. The S meter provides short-term
peak-hold metering. The M meter provides momentary peak-hold metering. For both meters, signal levels
display in Loudness K-weighted relative to full scale, per ITU BS 1770.

Figure 4: Loudness meters

Analysis tabs: :

• Dolby Atmos: Provides loudness measurement for a Dolby Atmos master file based on your selected 5.1
monitoring mode.

• Stereo/Binaural: Provides loudness measurement based on the stereo downmix mode selected for
monitoring, or binaural when Binaural is selected as the Render mode in Headphone preferences.

Reset button  : Click this button to reset the loudness measurements display to its default state of no

information. You might do this, for example, before you play back a different master, or section of a master.

Note: The loudness measurements will not automatically reset when unloading or reloading a
master, or when returning to the beginning of a master and playing the master again. Reset must
always be done manually.

Pause button  : Click (highlight) this button to stop calculations and capture the display of loudness

information for a specific moment in the audio playback. Click the button again to resume receiving
loudness calculations in the display. This is useful if you wish to pause measurements in order to exclude a
loud section of program material from your total calculation.

Measuring loudness
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Loudness measurements display:

• Short term: This value represents a three-second window of the loudness (which is also displayed in the
S meter of the LKFS loudness meter pair)

• Momentary: This is an instantaneous reading of the loudness (which is also displayed in the M meter of
the LKFS loudness meter pair).

• Integrated: This is the integrated loudness measurement, per ITU 1770-4), in LKFS.
• Integrated (dial): This is the integrated loudness measurement with dialogue gating applied, in LKFS.
• Speech: This is the percentage of speech within the program material that is calculated by the Dolby

speech-detection algorithm.
• Range: In LU. This is the loudness range of the program material.
• True peak: In dBTP. This is the true peak value of the program material.

Measuring the loudness of a master offline

You can measure the loudness of a master or section of a master while offline.

After measuring the loudness, you can then export the loudness measurements for Dolby Atmos or Stereo/
Binaural as a time line (.csv file) or summary (.txt file).

• Summary: The summary .txt file provides the loudness information for the whole file.
• Timeline: The time line .csv file gives a reading of measurements for every second of the master. This can

be useful for finding places where you may have exceeded targets of the loudness specification that you
are working towards.

To measure loudness offline:

1. In the Renderer, load a master.
2. In the Renderer window, choose Window > Analyze Loudness. Alternatively, you can press Command +

L (Mac) or Control + L (Windows).
3. In the Analysis in/out section, set the length of the audio to be measured by performing one of these

tasks:

• Click Entire master to use the in and out points of the entire master.
• Define the in and out points of the audio to be measured:

• Click Set manually.
• In the In field, type in the timecode value where the loudness measuring should start.
• In the Out field, type in the timecode value where the loudness measuring should end.

4. Click the Analyze loudness button to begin the analysis.

A progress bar displays to note the analysis status. When analysis completes, the results are available for
two types of loudness measurements: Dolby Atmos and Stereo.

New in version 3.4
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5. Click the Dolby Atmos or Stereo tab to display the respective analysis.

• Dolby Atmos: Provides loudness measurement for a Dolby Atmos master. This measurement is based
on your selected 5.1 monitoring mode and applied trims.

• Stereo/Binaural: Provides loudness measurement for a stereo component of your Dolby Atmos
master, based on the stereo downmix mode selected for monitoring, or binaural when binaural is
selected in Headphone preferences.

Loudness measurements include:

• Integrated: This is the integrated loudness measurement, per ITU 1770-4), in LKFS.
• Integrated (dial): This is the integrated loudness measurement with dialogue gating applied, in

LKFS.
• Speech: This is the percentage of speech within the program material that is calculated by the Dolby

speech-detection algorithm.
• Range: In LU. This is the loudness range of the program material.
• True peak: In dBTP.

6. Click the Export loudness report drop-down menu, and then select the report type (Summary or
Timeline).

Note: The Export loudness report drop-down menu name is based on the analysis type
(Dolby Atmos, Stereo, or Binaural).

7. Define the destination path and file name for the exported loudness measurements, and then click Save.

The loudness measurement file is saved to the location you defined.
8. Click Close to close the Loudness Analysis window.

Considerations when measuring loudness

• Ensure that downmix settings in the master are the same as the monitoring settings: Loudness settings
are affected by the downmix monitoring settings in the Trim and downmix control window. To ensure
that the settings written in the master are what is being measured, click the link icons for 5.1 downmix

Measuring loudness
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monitoring/re-renders and 5.1 to stereo downmix monitoring/re-renders so that the monitoring
settings match the respective downmix in master settings, and then do the loudness measurement.

• There can be slight differences between real-time and offline loudness measurements due to buffering
and speech-percentage calculations. The offline calculations are always more accurate.

• To avoid inconsistencies in loudness measurement at different stages of the workflow, use the loudness
re-render when loudness measurement is performed externally via a standalone application or DAW
plug-in. Specifically, the loudness re-render employs a limiter to accurately reflect the loudness measure
used in Dolby encoding solutions.

2.2 New re-render options: 7.1.4 and Loudness
The re-render output matrix includes two new layouts: 7.1.4 and Loudness. These layouts are available when
you create and map a re-render while configuring the re-render output matrix. The layouts appear as
options in the Layout drop-down menus in the Re-renders and Properties windows.

Use the Loudness layout (which is a 5.1 layout) for loudness measurements. For example, run the loudness
re-render into the DAW if you are using an external loudness plug-in. This will be more accurate than running
a standard 5.1 re-render into an external plug-in.

2.3 Limiting on output and re-renders
Processing preferences includes an option for turning on output limiting.

When the Output limiting option is on, the Renderer applies a soft clip limiter to speaker monitoring,
headphone monitoring, and re-renders.

To turn on limiting:

1. In the Dolby Atmos Renderer, choose Dolby Atmos Renderer > Preferences to open the Preferences
window.

2. Select (highlight) Processing to navigate to the Processing preferences page.

New in version 3.4
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3. Click the Output limiting switch so that the option is on. The switch turns blue when on.

By default, output limiting is on.

Note: The output meters are placed before the limiter meter when a limiter meter is shown in the
user interface (UI). This is a representation of all the limiting applied to the summation of all
output channels of the selected monitoring layout. The output meters still show prelimiting
values, enabling you to see which outputs are hitting the limiter.

While the soft clip limiter will prevent hard clipping in the outputs, for best results we
recommend decreasing the level to ensure that clipping is kept to a minimum.

2.4 Group improvements
After a master is created, you can now manage and reassign groups.

• In the Groups window, you can add, rename, or delete a group.
• In the Input configuration window, you change the group assignment for any bed.

2.5 Display of object numbers or binaural distance model settings
of objects in objects view
In the objects view, you can display numbers for each object or the binaural distance model settings (off,
near, mid, and far) for each input object.

Group improvements
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Figure 5: Binaural distance model settings shown (in theater view)

Note: The binaural distance model settings are defined in the Binaural render mode window.

To show object numbers of binaural distance model settings:

1. Click the small box icon drop-down menu in the top-right corner of the objects view to reveal View and
the Show option.

2. Perform one of these steps:

• To display numbers for each object, select Object numbers.
• To display the binaural distance model settings of each object, select Binaural settings.

2.6 Synchronization updates
The Renderer now includes offset controls for aligning timecode to audio and an linear timecode (LTC)
Generator plug-in for sending LTC over audio from Pro Tools to the Renderer.

Aligning timecode to audio

You can add offset to timecode (in samples) to better align timecode to audio if you are routing timecode
through a different A/D converter to your audio. You access these controls via the new Advanced Settings
menu and Audio to Timecode Alignment submenu.

New in version 3.4
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Note: If you are using Dolby Atmos Production Suite on an in-the-box workflow you, or Dolby Atmos
Mastering Suite in a two-machine setup using qualified hardware, you will not need to adjust these
advanced settings.

To align timecode to audio:

1. Determine the timecode latency of your system.

See Determining the timecode latency of your system  in the Renderer Guide .
2. Choose Advanced Settings > Audio to Timecode Alignment.
3. In the Audio to timecode alignment window, set the timecode offset, based on timecode type and

sample rate, and where applicable, the suite license.

Choices include:

• LTC over audio timecode offset, in samples at 48 kHz
• LTC over audio timecode offset, in samples at 96 kHz
• LTC over ASIO timecode offset, in samples at 48 kHz
• LTC over ASIO timecode offset, in samples at 96 kHz
• MTC timecode offset, in samples at 48 kHz
• MTC timecode offset, in samples at 96 kHz

4. Click Accept.

Dolby LTC Generator plug-in, for sending LTC over audio from Pro Tools to the Renderer

The Renderer installer now includes a Dolby LTC Generator plug-in, which is used for sending LTC over audio
from Pro Tools to the Renderer (for example, on systems using the Dolby Audio Bridge). The plug-in is an
Avid Audio eXtension (AAX) mono plug-in.

Figure 6: Dolby LTC Generator plug-in,

To send LTC from Pro Tools to the Renderer:

1. Make sure the Renderer and Pro Tools are open.
2. For the Pro Tools session, use the desired session template and input/output (I/O) settings.
3. Verify that Renderer Driver preferences are set correctly.

• Driver: Core Audio
• Audio input device: Dolby Audio Bridge or other input device
• Audio output device: Your output device

4. Set the External sync source to LTC over audio.
5. Set the LTC input channel to 129 (or 130).

If the LTC input channel is set to a channel with an object assigned to it, that object will not output
sound.

Synchronization updates
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6. In Pro Tools, create a new mono track.
7. Set the output to the LTC input channel number that was set in the Renderer (129 or 130).

If you are using a Dolby-supplied template and I/O settings file for systems using the Dolby Audio Bridge,
the channels are labeled: TC Ch 129 (Mono) → LTC Ch 129 and 130.

Note: Ensure that the signal is not output to a speaker.
8. Insert a Dolby LTC Generator plug-in on the track.

Note: When sorting plug-ins by type, the Dolby LTC Generator plug-in is located in the Other
category.

2.7 Trims and downmix controls included with the Production Suite
The Production Suite now includes the ability to write the trim and downmix settings to a master file. These
are available in the Trims and downmix controls window (accessible via Windows > Trim and Downmix
Controls).

Use the trims and downmix controls for:

• Writing downmix metadata in a master
• Writing trim metadata in a master

2.8 Additional improvements and changes
Renderer v3.4 includes miscellaneous improvements and changes.

• The 5.1 and stereo downmix type written to the master in downmix settings, as well as the trims settings,
are now included in the MP4 export.

This means that the MP4 export can be used to monitor the mix on a Dolby Atmos enabled system, or a
5.1 or stereo system.

• The Dolby Atmos Panner plug-in has been removed from the Dolby Atmos Renderer v3.4 installer and is
not supported with Renderer v3.4 running on macOS Catalina. As a workaround, use the object panners
included with Pro Tools, or the Dolby Atmos Music Panner (available from Dolby). Alternatively, you can
use the Dolby Atmos Panner included with Renderer v3.3 and earlier on supported versions of macOS
Mojave and High Sierra.

• Low-Frequency Effects (LFE) limiter removed.

Previous versions of the Renderer included a limiter in the LFE with a -10 db threshold. This limiter has
been removed. This allows users to write higher levels of LFE in re-renders.

Note: To ensure correct monitoring, the LFE channel must be calibrated such that each 1/3-
octave band between 20 and 80 Hz is 10 dB higher than the equivalent 1/3-octave bands for any
of the full-range speakers, assuming that the full-range speaker is ideally flat. This level is read
from a real-time analyzer (RTA), rather than a sound pressure level (SPL) meter.

• Descriptions for beds and objects (as defined in the Input configuration window) are now also shown in
the Binaural render mode window.

New in version 3.4
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Figure 7: Binaural render mode window

• In the Binaural render mode window, Backwards Compatibility mode has been removed. You can now
always write metadata for beds and objects in this window.

2.9 New in previous versions
This version of Dolby Atmos Renderer includes new features, improvements, and fixes that were included
with previous versions.

2.9.1 New in version 3.3
Dolby Atmos Renderer v3.3 includes new features, improvements, and fixes for using Dolby Atmos Renderer
software to author content in Dolby Atmos.

New in previous versions
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• Ability to export to MP4 file format.

This allows you to export Dolby Atmos content for playback on Dolby Atmos-enabled consumer devices
(such as a Blu-ray player or Dolby Atmos-enabled sound bar). For example, you can save the .mp4 file to a
Universal Serial Bus (USB) stick, connect the stick to a USB input port on the device, and then play back
the file on the device.

An exported Dolby Atmos .mp4 is for QC of Dolby Atmos content only. It is not for QC of 5.1 or stereo
downmixes.

The .mp4 file will be a multiplexed Dolby Digital Plus with Dolby Atmos content and black 720 x 1280 .h264
video elementary stream at the frame rate of the master file.

The master must be 48 kHz. The Export Audio > MP4 command does not support 96 kHz Dolby Atmos
masters.

Procedure (to export a master to .mp4):

1. With a master loaded, choose File > Export Audio > MP4. Alternatively, you can press Command +
Shift + M (Mac) or Control + Shift + M (Windows).

Figure 8: Choosing the Export Audio > MP4 submenu command

2. In the File name field, enter a name for the .mp4 file.

Figure 9: Export master to .mp4 dialog

3. Click the Choose directory button, and set a path for the .mp4.

New in version 3.4
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4. In the Export settings section, select the Encoding mode: Film or Music.

The encoding mode defines the encoding profile applied during the creation of the .mp4 file.
5. In the Export settings section, in the Export in/out section, set the length of the exported master.
6. Click Export. During the export, a window overlay provides feedback to show the status of the export.
7. When the export has completed (100%), click Close.

The dialog closes.
• Improved binaural headphone monitoring

Size information and LFE signal is now included in the binaural output.
• Binaural rendering mode updates

• Ability to import or export binaural rendering mode configurations, via the Import Input/
Binaural/Re-render Config and Export Input/Binaural/Re-render Config menu commands and
dialog.

The Import input/binaural/re-renders configuration file dialog includes options to import
configurations for input, input and binaural render mode, and re-renders.

Figure 10: Import input/binaural/re-renders configuration file dialog

• In the Binaural render mode window, all LFE channels are now set to Off and cannot be changed.
This includes masters created with Renderer v3.2 that were saved with the LFE channel not set to Off.

• Changes to stereo downmix settings

The preferred stereo downmix type can now be written into the master file using Dolby Atmos Mastering
Suite.

• New view options for objects view.

Click the small box icon drop-down menu in the top right corner of the objects view to reveal options. To
select an option, click the option.

Note: To close the box icon drop-down menu, click on the menu arrow, or click in any unused
area in the Renderer window that is outside the objects view.

View options include:

• Theater: This view is the same as the view provided in earlier versions of Renderer v3.x. In this view,
objects use the full room, with zero height being shown at floor level. Additionally, the front of the room
includes a white screen.

• Person: This view includes a representation of a listener in the center of the room. Objects at zero height
appear at the ear level of the listener.

New in version 3.3
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Figure 11: Person view in the objects view

Show option includes:

• Object number: When selected, the object number for each object in the room is displayed below the
object. This option is supported in theater or person view.

New in version 3.4
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Figure 12: Person view with Show >Object Number enabled

• Headphone output updates

Headphone limiter now applied to the binaural headphone output only. The stereo headphone output
now clips at zero to simulate the real clip level.

Note: The binaural limiter is still applied to the binaural re-renders.
• Changes to Pro Tools templates included with the installer.

• Pro Tools session templates for setups using Send and Return plug-ins have been updated and
renamed. Template names are based on the system setup and use of mono or stereo plug-ins.

• For Pro Tools setups that use the Dolby Audio Bridge, Pro Tools session templates have been updated
and renamed, plus the installer includes Pro Tools I/O .pio settings files. Template and settings file
names are based on the system setup and use of mono or stereo plug-ins.

2.9.2 New in version 3.2
Dolby Atmos Renderer v3.2 includes new features, improvements, and fixes for using Dolby Atmos Renderer
software to author content in Dolby Atmos.

• Ability to open and export IMF immersive audio bitstream (IAB) .mxf files
• Array mode (Dolby Atmos Mastering Suite):

• Enables Home Theater content to be created in rooms that have small speaker arrays. This mode can
be activated in the Room Setup window.

Note: When working in array mode, you can monitor the physical layout (which you define in
the Speaker setup page in the Room setup window). Additionally, the Renderer provides
channel-based renders for monitoring. These are based on the physical layout. For example,
with a physical layout using all speakers and arrays, these channel-based renders are
available: 7.1.2, 7.1, 5.1.2, 5.1, and 2.0.

New in version 3.2
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• Includes control of equalization (EQ), delays, and gains of arrays (when in array mode)
• Downmix settings

The 5.1 downmix type is now contained within the master. It can be written using Dolby Atmos Mastering
Suite or read by both Dolby Atmos Mastering Suite and Dolby Atmos Production Suite.

• Improvements to overall performance and central processing unit (CPU) usage
• Smoother transitions between monitoring options.
• Headphone limiter: A limiter is applied to the headphone output. Limiting affects monitoring (at the

spatial coding output prior to rendering to speakers), and is also applied to binaural re-renders.
• System settings automatically backed up when upgrading from previous versions of the Renderer.

Settings are backed up as an .atmoscfg file that is saved on your local drive.
• VR mode removed

VR mode, VR panner plug-ins, and the VR transcoder have been removed from the Dolby Atmos
Renderer.

• Playing back DAW audio from the Speaker calibration window:

External signal fed into the Renderer can play back when applying gain, delay, or EQ in the Speaker
calibration window. In previous versions of the Renderer, external audio would be muted when the
Speaker calibration window was open.

2.9.3 New in version 3.0.2
Dolby Atmos Renderer v3.0.2 includes new features, improvements, and fixes for using Dolby Atmos
Renderer software to author content in Dolby Atmos.

• Supports control of level, mutes and dims via an Avid System 5 digital audio system (or other control
surface using commslib).

• Binaural rendering performance at 96 kHz improved.
• Improved trim functionality. (Dolby Atmos Mastering Suite only)
• Room EQ can now be used to set bass managed speakers. (Dolby Atmos Mastering Suite only)

2.9.4 New in version 3.0.1
Dolby Atmos Renderer v3.0.1 includes new features, improvements, and fixes for using Dolby Atmos
Renderer software to author content in Dolby Atmos.

• Ability to automatically number object descriptions sequentially (in the Input configuration dialog
Description column).

• 5.1 downmix drop-down menus include two Direct render options: Direct render and Direct render
without warp.

• In the Record in/out section, ability to use the Tab key to move the cursor between the In point and Out
point settings.

• Improved re-render naming when creating re-renders offline (with File > Export Re-renders).

Each mono .wav file is now named with the channel number and then the channel type at the end of the
file name (before .wav). This better prepares the files for importing into a DAW.

The naming convention for an exported re-render .wav file is <export_file_name>_<re-
render_name>_<channel_number>.<channel>.wav, where

• Exported re-renders timestamped in accordance with the Broadcast Wave Format (BWF) format
standard.

Each re-render .wav file is timestamped with the start time. This lets you import the files into a DAW and
have them appear in the correct position on the timeline.

• Ability to export re-renders as interleaved multichannel .wav files.
• Access to log information via the Open Logs Folder command in the Help menu.

New in version 3.4

Dolby Atmos Renderer v3.4 Release Notes 22

2 March 2020



3 

Introduction to the Dolby Atmos Renderer
The Dolby Atmos Renderer provides the software components required to monitor, create, and play
back Dolby Atmos masters.

• Dolby Atmos suites and the Renderer
• Dolby Atmos Renderer installer components
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3.1 Dolby Atmos suites and the Renderer
The Dolby Atmos Renderer is included in two different Dolby Atmos suites: Dolby Atmos Mastering Suite and
Dolby Atmos Production Suite. Depending on the suite license, different features are provided.

Figure 13: Dolby Atmos Renderer main window (shown with loudness measurement disabled)
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3.1.1 Dolby Atmos Mastering Suite software package
The Dolby Atmos Mastering Suite package includes the Dolby Atmos Renderer, which provides the software
components required to monitor, create, and play back Dolby Atmos masters for home theater and music.

This suite is for engineers, sound designers, and others who use Dolby Atmos Renderer software for creating
and monitoring high-value complex content for home distribution (Blu-Ray, and over‑the‑top (OTT)) on a
multiple computer system that supports full EQ calibration and includes a dedicated rendering and
mastering workstation for power on demand.

The Dolby Atmos Mastering Suite includes one license for Dolby Atmos Mastering Suite and three licenses for
Dolby Atmos Production Suite.

Use the Dolby Atmos Mastering Suite to run the Renderer on a rendering and mastering workstation, which
is a dedicated Mac or Windows machine with a Dolby-specified hardware configuration. Use the Dolby
Atmos Production Suite to run the Renderer in-the-box (on a single computer) to monitor, create, and play
back Dolby Atmos content in a premix or editorial workflow.

The Dolby Atmos Renderer installer includes the Dolby Atmos Renderer Remote application. This
application controls the Renderer on the rendering and mastering workstation from a computer on the
same network. The Renderer Remote application does not require a license.

3.1.2 Dolby Atmos Production Suite software package
The Dolby Atmos Production Suite package includes the Dolby Atmos Renderer, which provides the software
components required to monitor, create, and play back Dolby Atmos content in a premix or editorial
workflow.

Introduction to the Dolby Atmos Renderer
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This suite is for engineers, sound designers, and others who use Dolby Atmos Renderer software in-the-box
(on a single computer) for editorial, premix, and sound-design workflows.

The Dolby Atmos Production Suite provides access to one license for running the suite on a supported Mac
CPU.

Note: The Dolby Atmos Renderer Remote application, included as an option when installing the
Renderer, is used for Dolby Atmos Mastering Suite workflows only. If you are working with the Dolby
Atmos Production Suite only, you do not need the Dolby Atmos Renderer Remote.

3.2 Dolby Atmos Renderer installer components
The Dolby Atmos Renderer installer provides software for mixing and recording Dolby Atmos content.

Table 1: Renderer installer components

Component Description

Dolby Atmos Renderer This application is required to render audio and Dolby Atmos metadata from a
supported DAW. The software supports various tasks, including monitoring a
Dolby Atmos mix, and recording or playing back a Dolby Atmos master.

Dolby Renderer Send plug-in (Mac
only)

This optional Pro Tools plug-in is installed with the Dolby Atmos Renderer and
can be used to send object or bed source audio to the Dolby Atmos Renderer
from Pro Tools. The Send and Return plug-ins are designed for in-the-box
workflows with the Dolby Atmos Production Suite, and can be used instead of
the Dolby Audio Bridge.

Dolby Renderer Return plug-in (Mac
only)

This optional Pro Tools plug-in is installed with the Renderer and can be used to
receive Dolby Atmos audio from the Dolby Atmos Renderer, and then route the
rendered mix to Pro Tools outputs. The Send and Return plug-ins are designed
for in-the-box workflows with the Dolby Atmos Production Suite, and can be
used instead of the Dolby Audio Bridge.

Dolby Atmos Renderer Remote
(Dolby Atmos Mastering Suite
workflows only)

This optional application enables remote control of a Dolby Atmos Renderer that
is running with a Dolby Atmos Mastering Suite license and is located on the same
network. In this configuration, the Dolby Atmos Renderer Remote on the DAW
machine controls the Dolby Atmos Renderer on the rendering and mastering
workstation.

Dolby Audio Bridge (Mac only) This optional Core Audio driver enables the rendering application to act as a
virtual Core Audio device. It supports routing audio (beds and objects) to or from
a DAW configured to use the bridge. Installing this component requires
restarting your computer.

Dolby LTC Generator plug-in This plug-in is required for synchronizing the Renderer to LTC as audio from Pro
Tools on systems using the Dolby Audio Bridge.

Documentation The installer includes user documentation for working with Dolby Atmos home
theater content.

Session templates (Mac only) The installer includes DAW session templates for creating a session that is
configured and ready for Dolby Atmos authoring. Dedicated Pro Tools and
Nuendo templates are provided and installed separately. Selecting the Pro Tools
template option also installs Pro Tools I/O settings files.

Additionally, you can download the Dolby Atmos Conversion Tool (from https://developer.dolby.com/forms/
dolby-atmos-conversion-tool. This tool enables you to convert one Dolby Atmos media file format to
another, or perform other conversion tool operations (such as changing the frame rate of a Dolby Atmos
media file).

Dolby Atmos Renderer installer components
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3.2.1 Dolby Atmos authoring documentation
The Dolby Atmos Renderer installer includes supporting documentation.

When selected during installation, documentation for Dolby Atmos Production Suite and Dolby Atmos
Mastering Suite on Mac is installed at ~/Applications/Dolby/Dolby Atmos Renderer/Documentation. For Dolby Atmos
Mastering Suite on Windows, documentation is installed at C:\Program Files (x86)\Dolby\Dolby Atmos Renderer
\Documentation.

After installation, installed documentation is also available in the Renderer. You can access an HTML version
of the Renderer guide via the Help > Dolby Atmos Renderer Guide menu command. You can access all
Renderer documentation via the Help > Open Documentation menu command.

Dolby Atmos Production Suite and Dolby Atmos Mastering Suite on Mac include the entire documentation
set. Dolby Atmos Mastering Suite on Windows does not include the documentation noted as Mac only.

Dolby Atmos Renderer Guide
This documentation provides information for using the Dolby Atmos Renderer and other Dolby Atmos
software to create or play back a Dolby Atmos master, listen to a Dolby Atmos mix, and pan audio
objects in a Dolby Atmos mix.

Dolby Atmos Renderer Release Notes
Refer to this documentation for installation instructions, new features and improvements, and known
issues.

New in Dolby Atmos Renderer
This documentation provides a list of what is new in the release. For releases with major UI changes, this
documentation details these changes as a primer to the main guide.

Dolby Atmos Production Suite Quick Start Guide  (Mac only)
This documentation introduces you to the Dolby Atmos Production Suite components and provides the
steps needed to install the suite and then verify your setup by playing audio from a supported DAW
session.

Dolby Atmos Renderer Third-Party Software
This documentation provides the third-party software licensed under open-source or proprietary
licenses that are incorporated into the Dolby Atmos Renderer software along with the required notices.

Dolby Atmos Plug-ins Third-Party Software
This documentation provides the third-party software licensed under open-source or proprietary
licenses that are incorporated into Dolby Atmos plug-ins along with the required notices.

3.2.2 Dolby Atmos Renderer DAW templates
The Renderer installer includes DAW templates for Dolby Atmos Production Suite workflows. Use the
installer to install templates on the computer running the DAW.

Pro Tools session templates for setups using Send and Return plug-ins
Pro Tools session templates for setups using Send and Return plug-ins are installed in a Pro Tools
session templates folder (~/Documents/Pro Tools/Session Templates/Dolby Atmos Production Suite).

Template names are based on the system setup and use of mono or stereo plug-ins

• Dolby Atmos Renderer Send Return Mono.ptxt
• Dolby Atmos Renderer Send Return Stereo.ptxt

Pro Tools session templates and Pro Tools I/O .pio settings files for setups using the Dolby Audio
Bridge

For Pro Tools setups that use the Dolby Audio Bridge, the Renderer installer includes Pro Tools session
templates and Pro Tools I/O .pio settings files.

Introduction to the Dolby Atmos Renderer
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Template names are based on the system setup and use of mono or stereo plug-ins

• Session templates are installed in a Pro Tools session templates folder (~/Documents/Pro Tools/Session
Templates/Dolby Atmos Production Suite).

• Dolby Atmos Renderer Dolby Audio Bridge Mono.ptxt
• Dolby Atmos Renderer Dolby Audio Bridge Stereo.ptxt

• Pro Tools I/O .pio settings files are installed in the Pro Tools IO Settings folder (~/Documents/Pro Tools/IO
Settings)

• Dolby Atmos Renderer Dolby Audio Bridge Mono.pio
• Dolby Atmos Renderer Dolby Audio Bridge Stereo.pio

Nuendo project template
The Nuendo session template is installed in a Nuendo project templates folder: Dolby Atmos Production Suite
- 128 channels) for Nuendo 10 is installed at Users/username/Library/Preferences/Nuendo 10/Project Templates/Dolby
Atmos Production Suite

Dolby Atmos Renderer DAW templates
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4 

Installing Renderer software
This documentation covers how to install Dolby Atmos Renderer software. For detailed information
about system configurations and installing the renderer and DAW on a Dolby Atmos system, see the
Dolby Atmos Renderer Guide.

• Requirements for a Dolby Atmos Production Suite system
• Requirements for a Dolby Atmos Mastering Suite system
• Activating a Dolby software license
• Installing the Dolby Atmos Renderer on Mac
• Installing the Dolby Atmos Renderer on Windows
• Launching the Dolby Atmos Renderer on a Mac
• Launching the Dolby Atmos Renderer on Windows

Installing Renderer software
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4.1 Requirements for a Dolby Atmos Production Suite system
The Dolby Atmos Renderer with a Dolby Atmos Production Suite license has been tested in these
configurations.

Setup CPU Operating system DAW

Renderer and Pro Tools on
a Mac (using Send and
Return plug-ins)

MacBook Pro 15,1; Intel Core i7
2.6 GHz, 16 GB RAM

macOS Mojave (version
10.14.4)

Pro Tools Ultimate
2019.10

MacBook Pro 11,5; Intel Core i7
2.8 GHz, 16 GB RAM

macOS High Sierra
(version 10.13.6)

Pro Tools Ultimate
2018.10

Mac Pro 6,1; 6-Core Intel Xeon
E5, 3.5 GHz, 32 GB RAM

macOS Mojave (version
10.14.5)

Pro Tools Ultimate 2019.6

Mac mini 8,1; Intel Core i7 3.2
GHz, 16 GB RAM

macOS Mojave (version
10.14.5)

Pro Tools Ultimate
2019.10

Mac mini 8,1; Intel Core i7 3.2
GHz, 16 GB RAM

macOS Catalina (version
10.15.3)

Pro Tools Ultimate
2019.12

Renderer and Pro Tools on
a Mac (using Dolby Audio
Bridge)

MacBook Pro 15,1; Intel Core i7
2.6 GHz, 16 GB RAM

macOS Mojave (version
10.14.4)

Pro Tools Ultimate
2019.10

MacBook Pro 11,5; Intel Core i7
2.8 GHz, 16 GB RAM

macOS high Sierra
(version 10.13.6)

Pro Tools Ultimate
2018.10

Mac Pro 6,1; 6-Core Intel Xeon
E5, 3.5 GHz, 32 GB RAM

macOS Mojave (version
10.14.5)

Pro Tools Ultimate 2019.6

Mac mini 8,1; Intel Core i7 3.2
GHz, 16 GB RAM

macOS Mojave (version
10.14.5)

Pro Tools Ultimate
2019.10

Mac mini 8,1; Intel Core i7 3.2
GHz, 16 GB RAM

macOS Catalina (version
10.15.3)

Pro Tools Ultimate
2019.12

Renderer and Nuendo on
a Mac

MacBook Pro 15,1; Intel Core i7
2.6 GHz, 16 GB RAM

macOS Mojave (version
10.14.4)

Nuendo 10.2.10

MacBook Pro 15,1; Intel Core i7
2.6 GHz, 16 GB RAM

macOS High Sierra
(version 10.13.6)

MacBook Pro 11,5; Intel Core i7
2.8 GHz, 16 GB RAM

macOS Mojave (version
10.14.5)

Mac Pro 6,1; 6-Core Intel Xeon
E5, 3.5 GHz, 32 GB RAM

macOS Mojave (version
10.14.5)

4.2 Requirements for a Dolby Atmos Mastering Suite system
The Dolby Atmos Renderer with a Dolby Atmos Mastering Suite license on the Dolby Atmos rendering and
mastering workstation, and a Renderer Remote on the CPU with the DAW, has been tested in these
configurations.

These tables provide the minimum hardware and operating system requirements.

The Mac and Windows Dell rendering and mastering workstation setups require a dealer-built workstation.
Contact your dealer for ordering details.

Requirements for a Dolby Atmos Production Suite system
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Table 2: Renderer on a Mac rendering and mastering workstation (using Dante I/O) and Pro Tools on a Mac

Hardware CPU Operating system Audio software Expansion chassis

Mac rendering and
mastering
workstation

Mac mini 8,1; Intel Core i7
3.2 GHz, 16 GB RAM

macOS Mojave
(version 10.14.5)

macOS Catalina
(version 10.15.3)

Renderer software Sonnet Echo III-D
chassis

Sonnet xMac mini
Server PCIe 2.0
Thunderbolt 3

Mac Pro 6,1; 6-Core Intel
Xeon E5, 3.5 GHz, 32 GB
RAM

macOS Mojave
(version 10.14.5)

Sonnet Echo III-D
chassis

Mac DAW machine Mac Pro 6,1; 6-Core Intel
Xeon E5, 32 GB RAM; AMD
FirePro D300 2,048 MB;
Sonnet xMac Pro Server
PCIe 2.0 expansion
system

macOS Mojave
(version 10.14.5)

Renderer Remote
software

Pro Tools Ultimate
2019.10

Table 3: Renderer on a Windows rendering and mastering workstation (using Dante I/O) and Pro Tools on a
Mac

Hardware CPU Operating system Audio software

Windows Dell rendering
and mastering
workstation

Windows Dell Precision Rack,
model 7920; Intel Xeon Silver
4114 2.2 GHz, 2,400 MHz, 10
Cores, 12 Logical Processors, 16
GB RAM

Windows 10 Pro for
Workstations

Renderer software

Mac DAW machine MacPro 6,1; 6-Core Intel Xeon
E5, 32 GB RAM; AMD FirePro
D300 2,048 MB; Sonnet xMac Pro
Server PCIe 2.0 expansion
system

macOS Mojave (version
10.14.5)

Renderer Remote
software

Pro Tools Ultimate
2018.10

Table 4: Renderer on a Windows rendering and mastering workstation (using MADI I/O) and Pro Tools on a
Mac

Hardware CPU Operating system Audio software

Windows Dell rendering
and mastering
workstation

Windows Dell Precision Rack,
model 7920; Intel Xeon Silver
4114 2.2 GHz, 2,400 MHz, 10
Cores, 12 Logical Processors, 16
GB RAM

Windows 10 Pro for
Workstations

Renderer software

Mac DAW machine MacPro 6,1; 6-Core Intel Xeon
E5, 32 GB RAM; AMD FirePro
D300 2,048 MB; Sonnet xMac Pro
Server PCIe 2.0 expansion
system

macOS High Sierra
(version 10.13.6)

Renderer Remote
software

Pro Tools Ultimate 2019.6

Installing Renderer software
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Table 5: Renderer on a Windows RMU (using MADI I/O) and Pro Tools on a Mac

Hardware CPU Operating system Audio software

Dolby Atmos Rendering
and Mastering Unit (RMU)

Dolby Atmos RMU Windows 7 Ultimate Renderer software

Mac DAW machine MacPro 6,1; 6-Core Intel Xeon
E5, 32 GB RAM; AMD FirePro
D300 2,048 MB; Sonnet xMac Pro
Server PCIe 2.0 expansion
system

macOS High Sierra
(version 10.13.6)

Renderer Remote
software

Pro Tools Ultimate 2019.6

4.3 Activating a Dolby software license
On a supported computer or iLok, activate the license that enables your software. We recommend that you
activate the license before you install the software.

Prerequisites

• Download and install the iLok License Manager from www.ilok.com.
• Ensure that you have iLok authorization for the license.

About this task

This task is performed in the iLok License Manager.

Procedure

1. Launch the iLok License Manager.

2. In the iLok License Manager window, sign in to your account, and then click (highlight) your account
name in the navigation bar.

Your account name is shown in the upper-left panel. Your host machine and iLok USB devices are shown
as icons in the panel below your account information.

3. Click the Available tab in the iLok License Manager header.

Figure 14: Available tab in iLok License Manager

If you do not see the Available tab, widen the application window until the tab is visible in the header.

The available licenses are shown under the tabs.

4. Locate the license for your software, and then drag and drop it to your host machine icon or to the iLok
device icon on the left.

5. Follow any additional onscreen instructions.

6. In the iLok License Manager window, repeat these steps if you are installing additional licenses to other
machines or iLoks.

4.4 Installing the Dolby Atmos Renderer on Mac
Depending on your system setup, install the Dolby Atmos Renderer components on the Mac that is running
your DAW, on a Mac rendering and mastering workstation, or both.

Activating a Dolby software license
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Prerequisites

• Ensure that the machine meets system requirements, including any required software. (See the
Dolby Atmos Renderer Guide  or Dolby Atmos Renderer Release Notes .)

• Ensure that you have activated the license for your software.

About this task

• When selecting which components to install, select the components that are required for your system
configuration.

• The installer also includes optional components (such as the Dolby Audio Bridge, documentation, and
templates). Choose optional components based on your Dolby Atmos Renderer configuration and needs.

• When the Dolby Audio Bridge option is selected, installation includes a restart of the Mac OS.
• When updating the Renderer or Renderer Remote software, the existing Renderer system settings are

automatically backed up as an .atmoscfg that is saved on your local drive (/Users/username/Library/Application
Support/Dolby/Dolby Atmos Renderer/Backups).

Procedure

1. If updating the Dolby Atmos Renderer and supporting software, ensure that the Dolby Atmos Renderer is
not running.

2. Double-click the Dolby Atmos Renderer .dmg file (Dolby_Atmos_Renderer-3.x.x-xxxxxxx.dmg).

This file provides access to the installer and documentation. Refer to the documentation for what is new
in this version of the Renderer, release notes (including known issues), and additional information.

3. Double-click the Dolby Atmos Renderer installer package (Dolby Atmos Renderer.pkg).

4. Follow the onscreen instructions.

5. When prompted to select which components to install, select the components required for your system
configuration, and then click Continue.

Installing Renderer software
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Figure 15: Default Installation Type page of the Install Dolby Atmos Renderer dialog

Note: You can click on an item in the Package Name column to reveal information about the
package.

6. Complete installation.

Installing the Dolby Atmos Renderer on Mac
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Note: If this installation is the first time you are installing Dolby software on the Mac, you may be
prompted with a dialog to enable any system extensions signed by Dolby. To use this application,
you must enable the Dolby extension. To continue installation, click Open Security Preferences,
and then enable any Dolby extensions in the Security and Privacy window.

Results
All items selected for installation are installed.

4.5 Installing the Dolby Atmos Renderer on Windows
Install the Dolby Atmos Renderer on a Dolby Atmos rendering and mastering workstation running on
Windows.

Prerequisites

• Ensure that the machine meets system requirements, including any required software. This includes
updated drivers.

• Ensure that you have activated the Dolby Atmos Mastering Suite license.
• When updating Renderer or Renderer Remote software, the existing Renderer system settings are

automatically backed up as an .atmoscfg file, which is saved to C:\ProgramData\Dolby\Dolby Atmos Renderer
\Backups.

About this task

When selecting which components to install, select the components that are required for your system
configuration.

The installer also includes optional components (such as documentation). Choose optional components
based on your Dolby Atmos Renderer configuration and needs.

Installation includes a restart of Windows.

Procedure

1. If updating Dolby Atmos Renderer and supporting software, ensure that the Dolby Atmos Renderer is not
running.

2. Double-click the Dolby Atmos Renderer .zip file (Dolby_Atmos_Renderer-3.0.0-xxxxxxx.zip).

This provides access to the installer and documentation. Refer to documentation for what is new in this
version, release notes (including known issues), and additional information.

3. Double-click the Dolby Atmos Renderer installer executable (Dolby Atmos Renderer.exe).

4. Follow the onscreen instructions.

Installing Renderer software
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5. Complete installation.

6. Set Performance options to Programs:

a) Navigate to Control Panel > System & Security > System > Advanced System Settings > Advanced.
b) In Performance Options click on the Settings button, select the Advanced tab, and under Processor

scheduling, choose Adjust best performance of: Programs.

4.6 Launching the Dolby Atmos Renderer on a Mac
After Dolby Atmos Renderer software is installed, you can launch the Renderer.

Prerequisites
Download and install the iLok License Manager from www.ilok.com.

About this task

You can perform this task with the Dolby Atmos Renderer using a Production Suite or Mastering Suite
license.

Depending on your system configuration, the Renderer will be on the computer running your DAW, or on a
Dolby Atmos rendering and mastering workstation.

Procedure

1. Locate the Dolby Atmos Renderer application name or icon.

The Dolby Atmos Renderer application is in the Applications/Dolby/Dolby Atmos Renderer folder.

Launching the Dolby Atmos Renderer on a Mac

Dolby Atmos Renderer v3.4 Release Notes 35

2 March 2020

http://www.ilok.com


Figure 16: Dolby Atmos Renderer icon

2. Double-click the Dolby Atmos Renderer application name or click the icon in the dock.

Results

The Dolby Atmos Renderer window displays.

4.7 Launching the Dolby Atmos Renderer on Windows
Launch the Dolby Atmos Renderer application on a Dolby Atmos rendering and mastering workstation
running Windows after completing the prerequisites for launching the application.

Prerequisites

• Download and install the iLok License Manager from www.ilok.com.
• To run Renderer v3.x on a Windows rendering and mastering workstation that has an older Renderer

version installed on it, you must change workstation settings before installing and launching Dolby
Atmos Renderer v3.x. The new settings will ensure that older Renderer software versions do not launch
on restart.

About this task

You can perform this task with the Dolby Atmos Renderer using a Production Suite or Mastering Suite
license.

Installing Renderer software
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Procedure

1. Locate the Dolby Atmos Renderer application name or icon.

The Dolby Atmos Renderer application is in the C:\Program Files (x86)\Dolby\Dolby Atmos Renderer folder.

2. Click the Dolby Atmos Renderer application name or icon.

The Dolby Atmos Renderer window displayed.

Figure 17: Dolby Atmos Renderer in Windows

Launching the Dolby Atmos Renderer on Windows
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5 

Known issues
This release has some known issues, for which we provide workarounds, comments, and solutions.

• A Dolby Atmos .atmosIR configuration file with special characters in the file name may cause errors
on import. As a workaround, do not use special characters with an .atmosIR configuration file.
[PRAU-736]

• Older versions of the Dolby Atmos Renderer Remote application will not connect to newer versions
of the Dolby Atmos Renderer. Install both the Renderer and Remote applications from the same
installer. [DACT-8989]

• Renderer v3.4 is not supported with macOS 10.14.2. Launching v3.4 on this macOS can result in a
black screen and is unusable. To avoid this, upgrade your macOS to a version tested for your
configuration. See System requirements  for your configuration. [PRAU-1194]

• An .atmos master file set that has naming differences between the .atmos, .audio, and .metadata files
will be corrupted on editing. [DACT-8670]

• Recording a master file over a network HDD is not supported. The recording process will be
stopped due to disk underruns produced by low transfer rates. [DACT-8802]

• When the 5.1 downmix is set to Standard (Lo/Ro) or Dolby Pro Logic IIx, and Spatial coding
emulation is off, object size is not applied. [DACT-8837]

• When localhost is used as the IP address to connect to a Renderer, aca double colon (::) is displayed
in the Network information page of the Preferences window. As a workaround, use a valid IP
address. [DACT-7996]

• When installing the Dolby Audio Bridge the first time, the bridge sometimes has to be reinstalled in
order for it to appear in the Renderer and Audio MIDI Setup drivers list. [PRAU-1152

• Using the Dolby Audio Bridge with some external hardware may result in clocking errors. As a
workaround, create an aggregate device with the Dolby Audio Bridge and your external hardware.
See Using the Dolby Audio Bridge as an Aggregate device  in the Dolby Atmos Renderer Guide .
[PRAU-1139]

• For systems with a dual-boot rendering and mastering workstation, Cinema Renderer services
have to be closed in order to use the Home Theater Renderer running with a Dolby Atmos
Mastering Suite license, and vice versa. [PRAU-589]

• Cinema Renderer settings containing 12.1 re-renders cannot be imported into Renderer v3.4. As a
workaround, remove the 12.1 re-renders using the Cinema Renderer before importing the settings.
[PRAU-1189]

• If the Dolby Atmos Renderer Remote application is launched before the Dolby Atmos Renderer, the
remote will not auto-connect to the Renderer. As a workaround, connect the Renderer Remote to
the rendering and mastering workstation using the IP address drop-down menu or launch the
Remote after launching the Renderer. [DACT-8012]

• Resetting the Renderer to the factory default does not reset the Loudness UI. As a workaround,
click the Loudness reset button, perform a factory reset, and then restart the Renderer.
[PRAU-1127]

• If an object is reassigned when signal is present, the signal may appear present in the previous
object. As a workaround, do not reassign objects while playing audio. [PRAU-1016]
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• When opening an Interoperable Master Format (IMF) IAB .mxf master via the Renderer Remote, and
the Renderer is in external sync and the transport is running, the master input configuration may
not be applied. When opening a master file, ensure that the transport is stopped. [DACT-9251]

• Exporting to MP4 with two or more successive commas (for example ",,,") in the file name will
produce an export error. As a workaround, use a maximum of one comma in a file name.
[PRAU-1147]

• In Windows, the Renderer will fail to initialize if you open the Renderer with a previously loaded
master from an encrypted drive that has not been unlocked. As a workaround, make sure the drive
has been unlocked before launching the Renderer. Alternatively, close the master before closing
the Renderer to avoid reloading the master upon launch. [DACT-8099]

• If the Core Audio input device or Core Audio output device is set to None, or if the field is empty,
when Core Audio is the active audio driver for the Renderer, an Audio driver error message is
displayed and the Renderer is not fully operational. Set the devices to available choices other than
None to make the Renderer fully operational. [DACT-6301], [DACT-8256]

• Connecting an audio device to your system while the Renderer is running may change the device
audio settings in your system. This can result in audio drops due to an invalid system setup, and
produce a log error (ERROR RendererExecutive audio device processor overload). If this occurs, check the
settings for the Audio Driver Configuration in the Renderer and the Mac Audio MIDI Setup. If the
settings are not correct, update them. [DACT-6280]

• Connecting or disconnecting headphones while the Renderer is running and using the Core Audio
Built-in output causes an audio driver error. This occurs because the Mac OS system changes the
device audio configuration. As a workaround, re-initialize the Renderer to reconfigures the Core
Audio driver. For example, choose Dolby Atmos Renderer > Preferences, and then click Accept.
[DACT-7902]

• Pro Tools Aggregate and Built-in output audio devices can intermittently, and without warning,
change the sampling rate to 44.1 kHz (typically, after a CPU overload). This sample rate change
causes rendered audio to be jittery. As a workaround, open the Mac OS X Audio MIDI Setup
application and select the 48 kHz sample rate. If 48 kHz is already selected, unselect it, and then
reselect it. [DACT-5484]

• When importing Dolby Atmos system settings from another computer, Core Audio input and output
device settings are not included. After importing system settings, an Audio driver error message
lets you know that the devices have not been accessed. As a workaround, navigate to Driver
preferences and add the input and output devices. [DACT-7227]

• Removing speakers in the physical room configuration (in the Speaker setup page of the Room
setup window) results in loss of calibration settings for those speakers. [DACT-8000]

• When in array mode, the output meters in the main Renderer window are post b-chain gain and
EQ. [DACT-9249]

• Dolby Atmos system configurations support only one Pro Tools recorder system at a time. For
example, if you enable Recorder mode on two Pro Tools systems, and then disable Recorder mode
on one of them, trying to record on the system still in Recorder mode results in no recorded
automation. To restore Recorder mode on this system, toggle Recorder mode off and on.
[DACT-2215]

• The Dolby Atmos Panner plug-in has been removed from the Dolby Atmos Renderer v3.4 installer
and is not supported with Renderer v3.4 running on macOS Catalina. As a workaround, use the
object panners included with Pro Tools, or the Dolby Atmos Music Panner (available from Dolby).
Alternatively, you can use the Dolby Atmos Panner included with Renderer v3.3 and earlier on
supported versions of macOS Mojave and High Sierra. [PRAU-1200]

• Do not use Dolby Atmos panners and Pro Tools object panners in the same session. For example, if
a Pro Tools track has an assigned Object Output Path and a Dolby Atmos panner plug-in inserted,
the Dolby Atmos panner object metadata will not be sent to the Renderer. The Pro Tools panner
metadata will change and overwrite the Dolby Atmos panner plug-in metadata. This can cause
unwanted recorded data. [DACT-7167].
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• You cannot lock a new master before recording any content. Doing so results in a Master file error
dialog, which reports that the master was not found. When you close the error dialog, the master
closes. [PRAU-124, DACT-8023]

• Pro Tools offline bounce is not supported with the Dolby Atmos Renderer. Attempting an offline
bounce on Pro Tools HDX systems can cause a crash. Attempting an offline bounce on a Pro Tools
native system can cause significant metadata loss. [DACT-6053], [DACT-5743]

• The Pro Tools scrubber tool is not supported when monitoring a Dolby Atmos master file.
[DACT-5859]

• If a Dolby Atmos Pro Tools session connected to a Renderer using the Send/Return plug-ins audio
driver is closed, the associated input channels in the Renderer remain active. To clear the meters,
re-initialize the Renderer (for example, by closing the Renderer and relaunching it). [DACT-5821]

• The Renderer can disconnect from the DAW with sessions that use the Dolby Atmos Music Panner
and have high channel counts and excessive Dolby Atmos metadata. [PRAU-998]

• Loudness meter data cannot be cleared when the Send/Return driver is selected and no Send or
Return plug-ins are inserted in the Pro Tools session. [PRAU-1025]

• When using the Send/Return plug-ins audio driver, ensure that the Pro Tools transport stops after
the recording end time. This ensures that the final master does not have any missing samples at
the end time. [DACT-7998]

• When using the Send/Return plug-ins driver, the Pro Tools pre-roll feature does not work. Instead,
the Renderer will start chasing LTC when the pre-roll period has ended. [DACT-8026]

• The Dolby Atmos Renderer does not support upper case master file extensions (such as .ATMOS) in
its input fields. Files with upper case file extensions fail to load. Change extensions manually to
lower case to load them into the Renderer. [DACT-5983]

• Playing back a master file from an external optical drive can result in undesired artifacts or glitches
when monitoring. As a workaround, open the master file from a fast SSD drive or from the internal
drive of the Renderer machine. [DACT-7969]

• Do not lock a new master before recording any content. Doing so results in a Master file error
dialog, which reports that the master was not found. When you close the error dialog, the master
closes. [DACT-8023]

• If master file content is present at the offset start time, playback without pre-roll may result in the
loss of the first buffer. To avoid this, always start playback with at least one frame of pre-roll. For
optimum performance, Dolby recommends pre-roll and post-roll of greater than two frames for
playback and recording. [DACT-6821]

• Before beginning the workflow to record a master using set in and out points, ensure that the DAW
session is open. If you set up the Renderer for recording, and then open a DAW session that has an
input configuration conflict with the Renderer, the Renderer will disarm the master when the In
point is reached and not provide any warning that this has occurred. [DACT-7132]

• Master files created in Renderer v3.0, v3.0.1, or v3.0.2 that have multi-beds containing binaural
render mode data do not play back correctly in v3.2 or later. Beds beyond channel 10 will be
muted. As a workaround, manually edit the master file, changing active:false to
active:true. [DACT-9066]

• When two machines are connected to the Renderer and the Renderer is recording audio and
metadata from a Pro Tools session on the first machine, opening a Dolby Atmos Pro Tools session
on the second machine that has object panners enabled on Object IDs that are being recorded to
by the Renderer will send metadata to the Renderer and overwrite metadata in the session on the
first machine. This can produce unwanted recorded data.[DACT-7380]

• During a punch in and out of a master recording at set points workflow, the master file audio mutes
after you press the record button and start playback, and then unmutes when the out point is
reached. This is because the Renderer toggles to Input mode when you press the record button.
[DACT-5972]

Known issues
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• With Pro Tools 2018.10 and earlier, when you import a 7.1.2 multichannel interleaved file, the
tracks are not imported in Film order. Instead, they are imported as L, C, R, Rrs, Lss, LFE, Lrs, Rss,
Lts, Rts. As a workaround, use multimono files. [DACT-8353]

• When exporting re-renders to an external drive, if the drive is unplugged during the export, the
export will continue and report a successful operation even if the re-renders where not successfully
written to the drive. As a workaround, do not unplug the destination drive when exporting re-
renders. [DACT-8006]

• Attempting to use a read-only directory to export re-renders, export an ADM BWF .wav, or create a
new master does not provide a descriptive error to the Dolby Atmos Renderer Remote application.
Instead, the error simply notes that the file was not written. As a workaround, choose a destination
directory that is not read only. [DACT-7568]

• When using Remote Desktop to manage installation of the Renderer on a Mac rendering and
mastering workstation, the Dolby Audio Bridge will not successfully install on the workstation. As a
workaround, install the Dolby Audio Bridge directly on the workstation. [DACT-7721]
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Glossary
.wav

Waveform Audio Format. An audio bitstream file format.

AAX
Avid Audio eXtension. A plug-in format for Avid Pro Tools software.

ADM
Audio Definition Model. A metadata model specified in ITU.R.BS.2076 that describes channel-, object-,
or scene-based audio file formats.

ASIO
Audio Stream Input/Output. A soundcard driver protocol from Steinberg Media Technologies GmbH that
allows musicians and sound engineers to access PC soundcards directly without going through
Microsoft Windows.

BWF
Broadcast Wave Format. An extension of the Microsoft Waveform Audio Format (WAV) file format to
include metadata important to broadcast applications. This format is specified in EBU Tech 3285.

B‑format
A speaker-independent representation of a soundfield.

CPU
Central processing unit.

DAW
Digital audio workstation. An electronic device or computer software application used to record, edit,
and produce audio files.

Dolby RMU
Dolby Rendering and Mastering Unit.

EQ
Equalization. The adjustment of audio frequency responses for practical or aesthetic reasons.

frame
In audio, a series of PCM samples or encoded audio data representing the same time interval for all
channels in the configuration. Metadata pertaining to the frame can be carried within the frame or
separately, depending on context.

frame rate
The number of frames decoded per second in real-time operation.

HD
High definition.

HTML
HyperText Markup Language.

Glossary
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I/O
Input/output. The communication between a system and an entity outside the system, such as another
system or a human being.

IMF
Interoperable Master Format. A SMPTE standard that defines an interoperable, file-based framework
designed to facilitate the management and processing of multiple versions of the same high-quality
finished work. See SMPTE ST 2067-2 and related documentation.

IP address
Internet Protocol address. A numerical identifier assigned to a device that is a member of a network that
uses the IP for communication.

LFE
Low-Frequency Effects. A band-limited channel specifically intended for deep, low-pitched sounds.

LTC
Linear timecode. A timecode developed by the Society of Motion Picture and Television Engineers
(SMPTE) that provides a time reference for editing, synchronization, and identification.

MADI
Multichannel Audio Digital Interface. A communications protocol for an interface that carries multiple
channels of digital audio, defined by the Audio Engineering Society. Also known as AES10.

MP4
A digital multimedia container format defined in MPEG‑4 (ISO/IEC‑14496, parts 12 and 14) most
commonly used to store video and audio streams.

object
An audio signal plus associated object audio metadata.

PC
Personal computer.

rendering
Processing of audio content to adapt it to specific speaker layouts, such as 5.1‑ and 7.1‑speaker feeds,
or headphones and sound bars.

RMU
Rendering and Mastering Unit.

UI
User interface.

USB
Universal Serial Bus. A standard that defines the cables, connectors, and communications protocols
used in connections between computers and electronic devices.
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